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Abstract 
 

The use of battery-based electric vehicles (BEV) continues to increase, so the ease of using the Public 

Electric Vehicle Charging Station (SPKLU) infrastructure for recharging electric vehicle batteries must be 

considered to enhance public confidence. One of the problems in using electric vehicles is the concern about 

long-distance travel (range anxiety) due to limited battery capacity and the minimal number of SPKLUs. 

This research aims to provide a tool to simulate access to charging stations across operators using the EV 

roaming method. In this approach, charging station users only need to register with one SPKLU operator 

to access charging stations owned by other operators. This research develops a set of simulation models, 

called the EV Roaming Simulator, to simulate several EV roaming scenarios concerning the basic 

functionality of four state-of-the-art EV roaming protocols. The simulator consists of three Open Charge 

Point Protocol (OCPP)-based models: the Charge Point Model, the Central System Model, and the National 

Access Point Model, each representing charging stations, central systems, and roaming hubs. The simulator 

is capable of executing the given EV roaming scenario. It has the potential to be further developed and used 

in developing various newly proposed EV roaming systems. 
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1. Introduction 

Battery-based electric vehicles (BEV) are 

increasingly used in various countries, including 

Indonesia. Electric vehicles are considered an important 

part of a sustainable transportation system, as they have 

the potential to reduce carbon emissions, improve air 

quality, and strengthen the resilience of national power 

grids. According to a report by the International Energy 

Agency (IEA), the number of electric cars worldwide is 

increasing significantly, with nearly 40 million on the 

road by 2023, compared to 26 million units in 2022 (IEA, 

2024). In addition, the IEA also predicts that the number 

of global electric vehicles will reach 85 million units by 

2025 and 270 million by 2030, with these predictions 

excluding two-wheelers and three-wheelers (IEA, 2022). 

According to the Indonesian Automotive Industry 

Association (Gaikindo), there has been a significant 

increase in sales of electric cars in Indonesia, as shown in 

Figure 1. Meanwhile, the Indonesian government targets 

2 million electric cars to be used in Indonesia by 2030. It 

will accelerate supporting infrastructure development to 

realize the national electric vehicle ecosystem (Ministry 

of Energy and Mineral Resources, 2024). 

Publicly accessible electric vehicle battery 

recharging infrastructure generally refers to charging 

stations connected to the grid and equipped with socket 

outlets to deliver power to electric vehicles. A vehicle 

inlet receives the power on the electric vehicle side. These 

two parts are connected by a cable with an interface as a 

plug at one end and a vehicle connector at the other, as 

shown in Figure 2. This accessory terminology is defined 

in the IEC 62196 standards published by the International 

Electrotechnical Commission (IEC). The battery in an 

electric car can be recharged with alternating current 

(AC) or direct current (DC). In AC charging, the On 

Board Charger in the electric car converts AC to DC to 

store energy in the battery, as shown in Figure 2. 

Meanwhile, in DC charging, the conversion from AC to 

DC is performed by the charging station (Dini et al., 

2023). Of course, the converters in charging stations have 

much greater capabilities than those in electric vehicles. 

Therefore, some charging stations, known as ultra-fast 

chargers, can deliver up to 350 kW and recharge electric 

car batteries quickly. 

Currently, electric vehicle drivers can only access 

charging stations belonging to the operator with whom 

they are registered as users. There is no collaboration 

among Public Electric Vehicle Charging Station 

(SPKLU) operators in Indonesia to enable inter-operator 

access to charging stations. There is no agreed-upon 
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roaming protocol among SPKLU operators for EV 

roaming. As a result, electric vehicle drivers have been 

unable to use charging stations operated by other 

providers. This is a problem because the charging 

infrastructure needed to support long-distance electric 

vehicle travel is still very limited (Yang et al., 2021). On 

the other hand, it is not easy to share real-time data among 

SPKLU operators, mainly due to interoperability 

constraints of data communication networks on electric 

vehicle charging infrastructure (Asensio et al., 2021). 

To support the realization of SPKLU operators in 

Indonesia, the government has issued Minister of Energy 

and Mineral Resources Regulation Number 1 of 2023 

concerning the Provision of Electric Charging 

Infrastructure for Battery-Based Electric Motor Vehicles. 

Article 14 stipulates the obligation of each SPKLU 

operator to have an online application for the recharging 

process of battery-based electric vehicles. The online 

application must provide features that are interoperable 

with online applications managed by other SPKLU 

operators. It must be integrated with the single gateway 

system owned by the Directorate General of the Ministry 

of Energy and Mineral Resources. This integration must 

be done one year after promulgating the ministerial 

regulation. 

Charging stations generally implement the Open 

Charge Point Protocol (OCPP), which has been de facto 

accepted as a standard. In OCPP, it is stipulated that the 

charging station (Charge Point) communicates with the 

central system (Central System) in the charging cycle of 

the electric vehicle within the internal SPKLU operator. 

The charging station is the client, and the central system 

is the server (Open Charge Alliance, 2017). Tokens, such 

as smart cards, access the charging stations. OCPP 1.6 is 

the most popular version, which provides the option of 

Simple Object Access Protocol (SOAP) or JavaScript 

Object Notation (JSON) via a WebSocket connection 

(JSON/WebSocket). This research chose 

Table 1. Basic functionality of EV roaming protocols (Kam & Bekkers, 2020) 
 

Basic Functionality OCHP 1.4 OICP 2.2 MIP 0.7.4 OCPI 2.2 

Roaming via hub √ √ √ √ 

Peer-to-peer roaming OCHPDirect 0.2  √ √ 

Remote start/stop √ √ √ √ 

Authorization √ √ √ √ 

Billing √ √ √ √ 

Synchronous data exchange  √ √ √ 

Asynchronous data exchange √ √ √ √ 

 
Table 2. Data element description of DataTransfer.req() in OCPP (Open Charge Alliance, 2017) 
 

Data Name Description 

vendor Required. Implementation identification code. 

messageId Optional. Additional identifier code. 

data Optional. Data in the form of a string object with no length requirement. 

 
Table 3. Data element description of DataTransfer.req() in OCPP (Open Charge Alliance, 2017) 
 

Data Name Description 

status Required. A status that indicates whether or not the data transfer was successful. 

data Optional. The response contains the requested data. 

 
Table 4. List of supporting devices for EV Roaming Simulator development 
 

No. Device Specification / Version 

1 Smart cards and readers ISO/IEC 14443 

2 Computer Windows 10 OS 

3 Java programming IDE Apache NetBeans IDE 19 

4 Central system platform RWTH Aachen University SteVe 3.4.5 

5 Java JDK Package JDK 18.0.2 

6 WebSocket API Java-WebSocket 1.5.1 

7 JSON Package json 20190722 

8 Smart card API jnasmartcardio 0.2.7 
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JSON/WebSocket-based OCPP 1.6 because the latest 

version no longer supports SOAP. 

This research develops a set of OCPP-based 

application programs called EV Roaming Simulator to 

simulate the basic functionality of four state-of-the-art 

EV roaming protocols, namely Open Clearing House 

Protocol (OCHP), Open InterCharge Protocol (OICP), 

eMobility Inter-operation Protocol (MIP), and Open 

Charge Point Interface (OCPI). The basic functionalities 

of the four protocols include (1) roaming via a hub, (2) 

peer-to-peer roaming, (3) remote start/stop, (4) 

authorization, (5) billing, (6) synchronous data exchange, 

and (7) asynchronous data exchange, as shown in Table 

1 (Kam & Bekkers, 2020). In the context of EV Roaming 

Simulator, OCPP is used to communicate between the 

central system and charging stations within the SPKLU 

operators and EV roaming among SPKLU operators. 

Meanwhile, due to technical considerations, the remote 

start/stop feature is not included in the implementation of 

the EV Roaming Simulator. 

Table 5. Parameters for National Access Point Model 
 

No. Parameters Description 

1 service_port WebSocket port number to provide the service (e.g., '9095') 

2 nap_service Service availability info access point (e.g., '/NAP/checkpoint/CPO') 

3 endpoint Access point for Central System Model (e.g., '/NAP/endpoint/') 

4 cpo_id Central System Model identifier code (e.g. 'CPO') 

5 known_token Recognized token code (e.g., '0102030409') 

6 other_central_ 

system_uri 

Other central system service access points (e.g., 'ws://192.168.1.7:9000/ 

steve/websocket/service/') 

7 charge_box_id Identifier code for obtaining services from other central systems (e.g., 'BRINTEST') 

 
Table 6. Parameters for Central System Model 
 

No. Parameters Description 

1 service_port WebSocket port number to provide the service (e.g., '9090') 

2 nap_service_uri Access point to ensure the availability of EV roaming services from the 

National Access Point Model (e.g., 'ws://192.168.1.7:9095/ 

NAP/checkpoint/CPO') 

3 endpoint Access point for Charge Point Model (e.g., '/service/endpoint/') 

4 charge_box_id Charge Point Model identifier code (e.g. 'CP') 

5 known_token Recognized token code (e.g., '0102030408') 

6 national_access_point_uri EV roaming service access point of the National Access Point Model (e.g., 

'ws://192.168.1.58:9095/NAP/endpoint/CPO') 

 

 

 

 
Figure 1. Electric Car Sales Trends in Indonesia (Gaikindo, 2024) 
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The significance of the EV Roaming Simulator, 

session across SPKLU operators without using actual 

products, in this case, actual charging station products 

and electric vehicles; can be used as a reference to 

understand charging sessions within SPKLU operators 

and in EV roaming among SPKLU operators; release 

dependence on EV roaming protocols managed by 

overseas parties,; can be used as a basis for charging 

standards and regulations across SPKLU operators in 

Indonesia and; can be further developed to simulate 

various EV roaming systems, which are new proposals. 

 

2. Materials and Methods 

The EV Roaming Simulator consists of three 

simulation models: the National Access Point Model, 

Central System Model, and Charge Point Model, 

representing the roaming hub, central system, and electric 

vehicle charging station. The methods used in the 

development include WebSocket cascades to connect the 

Charge Point Model to the Central System Model to the 

National Access Point Model, as well as OCPP 

functionality enhancement through the utilization of 

DataTransfer protocol data units to encapsulate the 

functions required in EV roaming. 

The details of the actors and roles applied to the 

EV Roaming Simulator are, The National Access Point 

Model functions as a roaming hub that supports EV 

roaming and is programmed as a WebSocket client and 

WebSocket server. The Central System Model performs 

central system functions in the internal SPKLU operator 

and is programmed as a WebSocket client and a 

WebSocket server. The Charge Point Model performs the 

function of an electric vehicle charging station internal to 

the SPKLU operator and is programmed as a WebSocket 

client. 

DataTransfer is a flexible protocol data unit that 

allows adding functionality that is not yet available. In 

EV roaming, DataTransfer can bring a variety of new 

functionalities by placing them as JSON objects on the 

'data' data element. This data element is capable of 

handling string objects of unlimited size. The data 

element details of DataTransfer (request-response pair) 
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Figure 2. AC and DC battery recharging scheme Figure 3. Simulation model development procedure 
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Figure 4. SteVe platform interface Figure 5. EV roaming simulator with WebSocket 

cascade 
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are shown in Table 2 and Table 3. Meanwhile, Gebauer 

et al. (2022) discuss using DataTransfer for confidential 

data exchange.The list of hardware and software 

supporting the development of the EV Roaming 

Simulator, among others, is shown in Table 4. 
Java was chosen as the programming language for 

all three simulation models. Here, an open-source central 

system platform developed at RWTH Aachen University, 

called SteVe (IDSG, 2020), serves as a functional 

reference in generating all required simulation models. 

The interface of the SteVe platform is shown in Figure 4. 

Steve supports up to OCPP 1.6. 

In Figure 3, it is illustrated that after confirming 

the reliability of SteVe as a central system in handling 

 
Figure 6. National Access Point Model Interface 

 

 
Figure 7. Central System Model Interface 
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actual charging stations, SteVe is used as a reference for 

creating the Charge Point Model. The same method is 

applied when creating the Central System Model, which 

takes the created Charge Point Model as a reference, and 

the National Access Point Model, which takes the created 

Central System Model as a reference. The Charge Point 

Model, Central System Model, and National Access Point 

Model are connected using the WebSocket cascade 

method, as shown in Figure 5. This connection creates a 

virtual channel for two-way data exchange that supports 

seamless communication for EV roaming or other 

purposes. When a WebSocket client actor sends data to a 

WebSocket server, the server can forward it to another 

server via another WebSocket connection, and so on, 

until the data reaches its final destination. 

In the three simulation models, namely the 

National Access Point Model, Central System Model, and 

Charge Point Model, some parameters must be set before 

each simulation model is run. The parameter values for 

each simulation model are contained in the "app.conf" 

file. The details are shown in Table 5, 6, and 7. 

 

3. Results and Discussion 

The user interface of the National Access Point 

Model is shown in Figure 6. The features in the user 

interface of the National Access Point Model are, the File 

menu contains the <Exit> option to end the National 

Access Point Model, and the Help menu contains the 

<About> option to display information about the National 

Access Point Model. <Business Model 1>, Business 

Model 2>, and Business Model 3> run scenario two, 

scenario three, and scenario four, respectively, as 

described by (Priyasta et al., 2023). The <Start/Stop 

Server> button starts or ends the National Access Point 

Model service, the <Clear Log> button clears the 

Table 7. Parameters for Charge Point Model 
 

No. Parameters Description 

1 central_system_ 

URI 

Central System Model service access point (e.g., 'ws://192.168.1.12:9090/ 

service/endpoint/') 

2 charge_box_id Charge Point Model identifier code (e.g. 'CP') 

3 authentication_ 

data 

The code of the token that made the transaction (e.g., '0102030407') 

4 delay_per_ 

message 

Time lag in milliseconds for communication between the Charge Point Model and the 

Central System Model (e.g., '2000') 

5 meter_value_ 

iteration 

Number of energy consumption data notifications informed to the Central System 

Model in one charging cycle (e.g. '4') 

 

 
Figure 8. Charge Point Model Interface 
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communication records in the log panel section, the log 

panel is used to display communication records. 

The user interface of the Central System Model is 

shown in Figure 7. The features in the user interface of 

the Central System Model are as follows, the File menu 

contains the <Exit> option to end the Central System 

Model, and the Help menu contains the< About> option 

to display information about the Central System Model. 

<No Roaming> and <Roaming> are options not to run 

and run EV roaming, the <Start/Stop Server> button 

starts or ends the Central System Model service, the 

<Clear Log> button clears the communication records in 

the log panel section, the log panel is used to display 

communication records. 

The user interface of the Charge Point Model is 

shown in Figure 8. The features present on the user 

interface of the Charge Point Model are, the File menu 

contains the <Exit> option to end the Charge Point 

Model, and the Help menu contains the <About> option 

to display the Charge Point Model information. The 

section labeled Central System URI contains the Central 

System Model access point parameters whose default 

values come from the "app.conf" file, and the 

<Connect/Disconnect> button is used to connect or 

disconnect with the Central System Model. The section 

labeled Authentication Data contains the token data 

parameters of the user performing the transaction, with 

the initial value (default) coming from the "app.conf" file, 

and the <GetUID> button is used to get the user token 

data through the smart card reader, in this case, the 

Unique Identifier (UID) of the smart card. The <Execute> 

button executes the charging session based on the EV 

roaming scenario. The <Clear Log> button clears the 

communication records in the log panel section. The log 

 
Figure 9. An example of scenario 1 in EV roaming 

 
 

Figure 10. An example of scenario 2 in EV roaming 



TEKNIK, 46 (1), 2025, 19 

 

doi: 10.14710/teknik.v46i1.67465               Copyright © 2025, TEKNIK, p-ISSN: 0852-1697, e-ISSN: 240-9919 

 

panel is used to display communication records. The 

upper description panel explains the textual 

communication. The bottom description panel is used to 

depict the communication taking place visually. 

An example of scenario 1 in EV roaming 

described by Priyasta et al. (2023) and executed by the 

EV Roaming Simulator is shown in Figure 9. The electric 

vehicle driver, D, is registered in the Central System 

owned by SPKLU operator 1, C1, and receives an 

authorized user token, T, to access the Charge Point 

operated by C1. Then, C1 shares the authorized user token 

data with the National Access Point, N, to authenticate 

electric vehicle drivers who want to use the Charge Point 

across operators. The same applies to other SPKLU 

operators. Currently, D needs to access the Charge Point 

owned by SPKLU operator 2, C2, using T. Here, C2 has a 

data set of authorized user tokens originating from N. 

Therefore, C2 can verify D to get access permission to 

Charge Point operated by C2. After D finishes using the 

Charge Point, C2 sends the billing as a Charge Detail 

Record (CDR) to C1 through N. According to Figure 9, 

the charging session starts with the Charge Point 

requesting the Central System to verify the token's 

validity that triggered the transaction. The Central System 

verifies the token's validity using the list of authorized 

token data sets (whitelist) from the National Access Point. 

The same authorization procedure applies when ending a 

charging session, the same token must be used. Finally, 

the Central System sends the Charge Detail Record 

(CDR) to the National Access Point for billing. 

Meanwhile, an example of scenario 2 in EV 

roaming described by Priyasta et al. (2023) and executed 

by the EV Roaming Simulator is shown in Figure 10. The 

electric vehicle driver, D, is registered in the Central 

System owned by SPKLU operator 1, C1, and receives an 

authorized user token, T, to access the Charge Point 

operated by C1. Currently, D needs to access the Charge 

Point owned by SPKLU operator 2, C2, using T. Here, 

both C1 and C2 have shared the authorized user token data 

with the National Access Point, N, for authentication of 

electric vehicle drivers who want to use the Charge Point 

across operators. Therefore, N can verify D to get access 

permission to the Charge Point operated by C2. After D 

finishes using the Charge Point, C2 sends the billing as a 

Charge Detail Record (CDR) to C1 through N. According 

to Figure 10, the charging session starts with the Charge 

Point requesting the Central System to verify the token's 

validity that triggered the transaction. The Central System 

then forwards the request to the National Access Point, 

which verifies the token's validity using a whitelist of 

authorized tokens from all SPKLU operators. This 

process aims to authorize the use of charging stations 

across SPKLU operators. The same authorization 

procedure applies when ending a charging session; the 

same token must be used. Finally, the Central System 

sends the Charge Detail Record (CDR) to the National 

Access Point for billing. 

 

4. Conclusion 

The use of electric vehicles continues to increase 

in various countries, including Indonesia. On the other 

hand, one of the problems in using electric vehicles is 

range anxiety due to limited battery capacity and minimal 

number of SPKLUs. One strategy many are 

implementing to increase SPKLU access is EV roaming, 

which allows users registered with other SPKLU 

operators access to charging stations. 

This research develops a computer program called 

the EV Roaming Simulator to simulate access to electric 

vehicle charging stations across SPKLU operators. The 

developed simulator consists of three OCPP-based 

models, namely the Charge Point Model, Central System 

Model, and National Access Point Model, representing 

charging stations, central systems, and roaming hubs. 

The methods implemented in the EV Roaming 

Simulator include a WebSocket cascade to connect the 

Charge Point Model to the Central System Model to the 

National Access Point Model, as well as enhancement of 

OCPP functionality through the utilization of 

DataTransfer protocol data units, which are used to 

encapsulate the functions required in EV roaming. With 

this approach, OCPP is used to communicate between the 

central system and charging stations within SPKLU 

operators and EV roaming among SPKLU operators. 

The EV Roaming Simulator is developed in Java. 

It can execute the given EV roaming scenarios to simulate 

the basic functionality of state-of-the-art EV roaming 

protocols, which include roaming via hubs, peer-to-peer 

roaming, authorization, billing, synchronous data 

exchange, and asynchronous data exchange. This 

simulator has the potential to be further developed and 

utilized in the development of various newly proposed 

EV roaming systems. 
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